SAFETY PRECAUTIONS
(Read these precautions before using this product.)

Before using this product, please read this manual and the relevant manuals carefully and pay full attention to safety to handle the product correctly.

In this manual, the safety precautions are classified into two levels: "\WARNING" and "\CAUTION".

| \WARNING  | Indicates that incorrect handling may cause hazardous conditions, resulting in death or severe injury. |
| \CAUTION  | Indicates that incorrect handling may cause hazardous conditions, resulting in minor or moderate injury or property damage. |

Under some circumstances, failure to observe the precautions given under "\CAUTION" may lead to serious consequences.

Make sure that the end users read this manual and then keep the manual in a safe place for future reference.

[Design Instructions]

WARNING

- When data change, program change, or status control is performed from a personal computer to a running programmable controller, create an interlock circuit outside the programmable controller to ensure that the whole system always operates safely. Furthermore, for the online operations performed from a personal computer to a programmable controller CPU, the corrective actions against a communication error due to such as a cable connection fault should be predetermined as a system.
- To maintain the safety of the programmable controller system against unauthorized access from external devices via the network, take appropriate measures. To maintain the safety against unauthorized access via the Internet, take measures such as installing a firewall.
CAUTION

• The online operations performed from a personal computer to a running programmable controller CPU (forced output and operating status changes) must be executed after the manual has been carefully read and the safety has been ensured. The operation failure may cause the injury or machine damage.
CONDITIONS OF USE FOR THE PRODUCT

(1) Mitsubishi programmable controller ("the PRODUCT") shall be used in conditions;
   i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident; and
   ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries. MITSUBISHI SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI'S USER, INSTRUCTION AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT. ("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in;

• Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the public could be affected if any problem or fault occurs in the PRODUCT.
• Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality assurance system is required by the Purchaser or End User.
• Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator, Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other applications where there is a significant risk of injury to the public or property.

Notwithstanding the above, restrictions Mitsubishi may in its sole discretion, authorize use of the PRODUCT in one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific applications agreed to by Mitsubishi and provided further that no special quality assurance or fail-safe, redundant or other safety features which exceed the general specifications of the PRODUCTs are required. For details, please contact the Mitsubishi representative in your region.
TABLE OF CONTENTS

SAFETY PRECAUTIONS .................................................................A-1
CONDITIONS OF USE FOR THE PRODUCT ................................A-3
TABLE OF CONTENTS .................................................................A-5

1 Architecture ...............................................................................1-1
  1.1 Introduction ............................................................................1-1
  1.2 What Is MC Historian? ...........................................................1-2
  1.3 What Is AlarmWorX Multimedia? ...........................................1-5

2 System Requirements ................................................................2-1
  2.1 System Requirements and Recommendations .......................2-1
  2.2 Data Sizing and Storage .........................................................2-3
    2.2.1 Disk Requirements for Software Components .....................2-3
    2.2.2 Disk Requirements for Configuration Database Files ...........2-3
    2.2.3 Disk Requirements for Historical Data Files .......................2-4
    2.2.4 Analog and Discrete Storage Requirements .......................2-5
    2.2.5 String Storage Requirements ..............................................2-6

3 MC Historian Configuration ......................................................3-1
  3.1 About the MC Historian Configuration Workbench .................3-1
  3.2 Starting the MC Historian Configuration Workbench ...............3-2
  3.3 Using the MC Historian Configuration Workbench .................3-2
    3.3.1 Starting and Stopping the MC Historian Logger .................3-2
    3.3.2 Viewing Licensing Information .........................................3-3
    3.3.3 Using TraceWorX ...............................................................3-4
    3.3.4 Configuring TraceWorX ......................................................3-4
    3.3.5 Viewing TraceWorX Generated Log Files .........................3-5
  3.4 Initial MC Historian Setup ......................................................3-6
  3.5 MC Historian Tag Organization ..............................................3-7
  3.6 Configuring a MC Historian Logger ........................................3-8
    3.6.1 Disk File Logger ...............................................................3-9
    3.6.2 Memory Persistent Logger ................................................3-10
    3.6.3 Deleting a MC Historian Logger .........................................3-11
    3.6.4 Managing Data Storage ....................................................3-11
  3.7 Configuring a MC Historian Logging Group .........................3-14
  3.8 Configuring a MC Historian Collector Group .........................3-15
  3.9 Configuring a MC Historian Tag ...........................................3-17
    3.9.1 Log to Disk Configuration .................................................3-19
    3.9.2 Deadband Filter Configuration .........................................3-20
    3.9.3 Swinging Door Filter Configuration ..................................3-21
    3.9.4 Configuring a Calculated Tag ...........................................3-25
    3.9.5 Creating a Calculation Trigger .........................................3-31
  3.10 Time Triggers for Calculated Tags .......................................3-32
  3.11 Data Triggers for Calculated Tags ........................................3-34
# TABLE OF CONTENTS

3.11.1 Organizing Tags into Folders ......................................................... 3-35
3.12 Configuring a MC Historian Aggregate Group ................................. 3-36
3.13 Configuring a MC Historian Aggregate Tag ..................................... 3-37
  3.13.1 Behavior of Aggregate Tags ....................................................... 3-37
  3.13.2 Aggregate Tag Configuration ...................................................... 3-38
3.14 SPC Configuration in MC Historian .............................................. 3-40
3.15 Configuring a UDM Trigger ............................................................... 3-43
  3.15.1 Configuring a Data Trigger ........................................................... 3-44
  3.15.2 Configuring a Time Trigger ........................................................ 3-45
3.16 Node Setup and Redundancy ............................................................. 3-46
  3.16.1 Configuring a Collector Node ....................................................... 3-47
  3.16.2 Configuring the Logging Server .................................................. 3-49
3.17 Configuring System Settings ............................................................. 3-51
  3.17.1 Configuring License Mode ........................................................... 3-51
  3.17.2 Configuring Archive Settings ...................................................... 3-53

4 Software Licensing ................................................................................ 4-1
  4.1 Software and Hardware Keys ............................................................. 4-1
    4.1.1 Software Licensing ................................................................. 4-1
    4.1.2 Hardware Key ......................................................................... 4-1
  4.2 Licensing Utility ............................................................................... 4-2
    4.2.1 Running the Licensing Utility .................................................... 4-2
    4.2.2 License File .............................................................................. 4-3
    4.2.3 Activating the 30-day Trial/Emergency License ............................ 4-4
    4.2.4 Killing a Software Key License .................................................. 4-6
  4.3 License Viewer ................................................................................. 4-9
  4.4 Web Licensing .................................................................................. 4-11
    4.4.1 Acquiring a New Software License ............................................ 4-11
    4.4.2 Adding to an Existing Software License ...................................... 4-18
    4.4.3 Upgrading a Software License Key ............................................. 4-20
    4.4.4 Upgrading a Hardware Key License ............................................ 4-27
    4.4.5 Licensing the New Version ......................................................... 4-27
    4.4.6 Software Key Replacement ....................................................... 4-28
  4.5 Demo Mode ..................................................................................... 4-29

5 Help and Technical Support ................................................................. 5-1
  5.1 Online Help ................................................................................. 5-1

6 Notes .................................................................................................. 6-1

REVISIONS
1 Architecture

1.1 Introduction

Companies today are faced with the need to perform efficiently and competitively with fewer resources. For plant-level operations, today's systems need to connect to different infrastructures for data gathering and users need to analyze and visualize data in real time. Access to plant data is fundamental to staying competitive and efficient. The demand to produce products faster or streamline operations is increasing across the globe. MC Historian enterprise-wide plant historian allows you to gain that competitive advantage, by organizing all your real-time information from across the enterprise.

MC Historian is high-speed, reliable and robust plant historian. In order to analyze and visualize data in real time, organizations must have access to plant data and reporting. MC Historian is designed to log large volumes of data, in excess of 100,000 updates per second, and connects to multiple data sources across the enterprise including OPC UA, OPC DA, OPC XML DA, BACnet, SNMP and many more. MC Historian also provides full, web-based configuration. Optional redundant configurations are supported using redundant MC Historian Collectors and redundant Loggers, and MC Historian offers Store and Forward technology as part of its integrated redundancy solution.

MC Historian optionally utilizes an advanced Swinging Door algorithm to allow for high compression, and takes full advantage of 64-bit hardware and software architectures, enabling it to access more CPU power and memory than traditional 32-bit-based historians and providing highest performance possible. The Swinging Door algorithm is available with configurable compression, but is based on a space-saving design that intelligently logs data without losing precision.
1.2 What Is MC Historian?

Features and Benefits of MC Historian include:

- High Performance 64-bit Scalable Plant Historian
- Archive and Compress Data at +100,000 Values/Second
- Hyper to Hyper Distributed Solutions
- Rich 2D and 3d Charts, Trends, Grids and Tables
- Desktops, Browsers. Phones and SharePoint Enabled
- Performance Calculation Engine Delivers Advanced Analytics
- Integrated Redundant Architecture for Mission Critical Solutions
- Remote Collectors with Reliable Store-and-Forward Technology
- Accessible via SQL Query Language OPC HDA and APIs
- Easily Merge Lab and other Offline Data with MergeWorX
- OPC, OPC UA, BACnet, SNMP, SQL, and Web Services
- Cloud MC Historian for Microsoft Azure

MC Historian can use Swinging Door data compression for storing huge volumes of quickly changing data. But, even without the Swinging Door data compression, it is capable of logging in excess of 100,000 data events per second on reference hardware for real-time, enterprise-wide information.

MC Historian also has robust, built-in software redundancy for mission critical applications that require uninterrupted access and collection of data. Automatic Store and Forward technology ensure data integrity, in the event of system upset or communications disruption.

MC Historian uses advanced data integration, providing unsurpassed connectivity to any device via OPC-UA,
Architecture

OPC-HDA, OPC XML, SNMP, BACnet or database values. Users can easily collect information from multiple plants, facilities or throughout the enterprise. Data sources such as PLCs, I/O devices, HMI applications and network devices can be collected and stored for reporting and analysis. MC Historian includes an industry standard SQL Query interface, enabling tight integration with Microsoft SQL-compatible database such as Microsoft SQL Server 2014. MC Historian also has a unique, automated archiving feature that allows for routine or triggered scheduling of data archives, freeing up disk space and backing up files for longterm storage and/or retrieval.

The Workbench inside MC Historian features a thin client, optimistic concurrent design, acting as the central configuration environment and operator interface. The runtime operational interface allows for complete visualization of real-time and historical data with 2D and 3D charts. The Workbench's advanced configuration console performs complete service management and has integrated layout/project management and remote pack-and-go deployment capabilities.

From the Workbench, operators can add fully customizable 3D trends and charts. Users can choose from a wide library of 3D charts such as X vs. Y, logarithmic, bar graph, strip chart recorder, circular and more, to build clear and accurate representations of real-time and historical data. Intuitive ribbons and galleries help to customize trends by adding color, gradients, smooth animation, translucency/glass effects, anti-aliasing and more, making data analysis clear and straightforward. Users can drag and drop sources during runtime and view multiple trends simultaneously.

Users can trend production numbers against a target. Data can also be exported in tabular formats and it is possible to enter operator comments, as well as manage lab data and audit trails in accordance with FDA 21 CFR Part 11 policies.
MC Historian can also connect with the entire BizViz Manufacturing Intelligence/Business Visualization suite, to create best-in-class reporting, analysis, portal or data bridging applications.

The following figure illustrates how MC Historian integrates with the Workbench, BizViz suite, third-party applications, remote data collectors and more.
1.3 What Is AlarmWorX Multimedia?

AlarmWorX Multimedia is the next generation of modular automation for advanced OPC-based HMI and Visualization by ICONICS. It is an option of AlarmWorX64 that provides OPC-compliant multimedia technology for remote alarm notification, enabling you to send and receive alarms using various multimedia agents.

Use the AlarmWorX Multimedia provider in the Workbench to configure alarms on several different types of media agents that can notify anyone, anywhere, of an occurring alarm. You can also use it to:

- Configure alarms, alarm action sets, multimedia agents, and alarm acknowledgement codes.
- Create subscriptions to OPC Alarm and Event (AE) servers.
- Configure schedules and destinations for alarm notification messages.

Multimedia agents you can use include:

- **Pager** agents that page you when an alarm occurs.
- **E-mail** agents that use standard email for alarms, acknowledgements, files, and more.
2 System Requirements

2.1 System Requirements and Recommendations
MC Historian Standard Edition has the following system requirements.

Supported Operating Systems
- Windows 10 (Enterprise or Pro Edition)
- Windows 8.1 x64 (Enterprise or Pro Edition)
- Windows 8 x64 (Enterprise or Pro Edition)
- Windows 7 64-bit (Professional or Enterprise Edition)
- Windows Server 2016 x64
- Windows Server 2012 R12 x64
- Windows Server 2012 x64
- Windows Server 2008 R2 64-bit
- Windows Vista x64 SP2 (Business, Ultimate, or Enterprise Edition)
- Windows Server 2008 x64

Minimum Requirements
- 1.6 GHz Dual/Multi Core 64-bit processor (AMD Athlon 64 X2, Intel Pentium D, Intel Core 2 Duo, Intel Xeon)
- 4 GB Physical Memory (RAM)
- 160 GB free hard disk space available
- 8x speed DVD-ROM optical drive
- 1024x768, 16-bit color display (minimum)
  1280x1024 32-bit color (or better), DirectX 9 Video Card or better (recommended)
- Microsoft.NET Framework 4.6
- Microsoft Internet Information Services (IIS) 7.0 or higher
- Microsoft SQL Server 2008 R2 SP1 or later Workgroup/Standard/Enterprise Edition
  OR
  Microsoft SQL Server 2008 R2 SP1 or later Express Edition with Microsoft SQL Server Management Studio Express
Requirements Notes:
Requirements described above are based on typical applications. Depending on your specific application, the minimum requirements may vary. Specific hardware requirements depend on the size and complexity of your MC Historian implementation. With any application, faster CPU speeds and increased physical memory (RAM) result in better performance.

Note: There is a compatibility issue between the WebHelp Help file format and Microsoft Internet Explorer 10. Upon first access of the Help file, some Help-related mechanisms embedded in the file may not initially work correctly. Such issues can be corrected by clicking on the Compatibility View icon (the 'broken in half' document image) in the right side of the browser address bar. You can also add your machine name or 'localhost' to the list of websites that will be shown in Compatibility View. Right-click in the top of the browser [away from the browser bar or tabs] to enable the 'Menu bar'. Once the Menu bar appears, click 'Tools', then 'Compatibility View settings'. Add your machine name or 'localhost' and close the window. Either method should now allow you to access MELSOFT’s WebHelp content as it was intended to be used.
2.2 Data Sizing and Storage

General Disk Space Requirements

When estimating the amount of disk space required to run MC Historian, be sure to consider:

- Available disk space to install required software components and files.
- Disk space required to store MC Historian data files.
- Disk space required to store the MC Historian archive data files themselves.

2.2.1 Disk Requirements for Software Components

The following table describes the *minimum disk space required* to install the software (besides the operating system) for MC Historian.

<table>
<thead>
<tr>
<th>Software</th>
<th>Minimum Disk Space Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td>See your Microsoft documentation.</td>
</tr>
<tr>
<td>Common Component Files</td>
<td>20 MB or more</td>
</tr>
<tr>
<td>MC Historian program files, including Workbench and documentation</td>
<td>300 MB</td>
</tr>
</tbody>
</table>

2.2.2 Disk Requirements for Configuration Database Files

All of the historian configuration data is stored within a separate database. The configuration data in the database file remains relatively static and usually never causes the file size to go above tens of megabytes.
Note: Historical plant data is not stored in the database files. This type of data is stored in special archive files.

The minimum disk space for the database files is as follows:

<table>
<thead>
<tr>
<th>File</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration database file</td>
<td>10 MB</td>
</tr>
<tr>
<td>Configuration log file</td>
<td>10 MB</td>
</tr>
</tbody>
</table>

The configuration database is set to automatically expand at a 10% rate (the default).

You cannot change these defaults during the installation. The databases can be resized later using Microsoft SQL Server utilities. For more information on sizing databases, see your Microsoft SQL Server documentation for guidelines.

2.2.3 Disk Requirements for Historical Data Files

MC Historian stores historical plant data to the hard disk in special archive files. By default during installation, the MC Historian is set up to log data to the following path: ProgramData\MELSOFT\MC Historian\Data. You may specify a different storage location (directory), after installation, in which these files are created and then filed. This can be done using the MC Historian Configurator System Administration/System Settings screen. Be sure that you have allocated sufficient disk space for storing plant data for your desired time frame.

The amount of disk-based storage that is needed depends on the number and frequency of stored tag values. The more tags, the fewer values that can be stored per tag before archiving the oldest data becomes necessary. The higher the specified tag storage rate, the faster you lose disk space.

Data Type Sizes:
### System Requirements

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Int8, UInt8</td>
<td>1 byte</td>
</tr>
<tr>
<td>Int16, UInt16</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Int32, UInt32</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Int64, UInt64</td>
<td>8 bytes</td>
</tr>
<tr>
<td>Float32</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Float64</td>
<td>8 bytes</td>
</tr>
<tr>
<td>Boolean</td>
<td>0 bytes</td>
</tr>
<tr>
<td>String</td>
<td>String length * 2 bytes</td>
</tr>
<tr>
<td>Timestamp</td>
<td>4 bytes</td>
</tr>
<tr>
<td>Quality</td>
<td>1 to 3 bytes (depends on presence of sub-status code and/or history bits)</td>
</tr>
</tbody>
</table>

#### 2.2.4 Analog and Discrete Storage Requirements

For analog and discrete tags, each value that is stored uses Storage size + 4 bytes of disk space, plus approximately 5% overhead. Use the following formula to estimate the disk usage:

Estimated disk usage per day = (Size + Timestamp + Quality + 1) * (1 + reserve in percent / 100) * Number of tags * [Approx. number of samples per day]

For example, the disk usage per day for 10,000 Float32 analog tags (Storage Size = 4 bytes) that are stored at 10-second intervals (i.e. 6 per minute * 60 * 24 = 8,640 samples/day) would be: (4+4+1+1)*(1+(5/100))*10000*8640 which is approximately 907 MB per day.
2.2.5 String Storage Requirements

For strings, the number of bytes required for storage will be the actual number of characters being sent from the data source + 14 bytes, plus 5% overhead. Therefore, the average disk usage per day for a variable-length string that is receiving an average of 'N' characters per sample could be calculated using the following formula:

\[
\text{Estimated disk usage per day} = (\text{Number of characters} \times 2) \times \left(1 + \frac{\text{reserve in percent}}{100}\right) \times \text{Number of tags} \times \text{[Approx. number of samples per day]}
\]

For example, the disk usage per day for 1,000 string tags that are changing, on average, every 60 seconds and the average incoming value is 50 characters in length would be \((50\times2)\times(1+(5/100))\times1000\times1440\), which is approximately 151 MB per day.
3 MC Historian Configuration

3.1 About the MC Historian Configuration Workbench

MC Historian is configured through the Workbench, an integral part of MC Historian and MC Works64 64-bit, OPC-integrated, Web-enabled HMI/SCADA suite. Workbench is loaded as part of the MC Historian installation and is a multi-functional, centralized, Web-based environment for product configuration.

**NOTE:** MC Historian can also be configured through Workbench-SL, a Microsoft Silverlight-integrated, browser-based configuration tool. For more information on the MC Historian "Provider" within the Workbench, consult the product's Help files.

The Workbench can also act as an advanced operator interface for visualization and service management and has integrated layout/project management and remote, pack-and-go deployment capabilities.
3.2 Starting the MC Historian Configuration Workbench

If you wish to launch directly from your desktop, click Start, then All Programs, then select MELSOFT Application > MC Works64 Application > MC Historian from the list.

If you already have a component running with Workbench, click the down-arrow in the bottom right corner of the Project Explorer navigation menu, then select MC Historian.

3.3 Using the MC Historian Configuration Workbench

3.3.1 Starting and Stopping the MC Historian Logger

The MC Historian Workbench contains a stoplight icon in the ribbon that lets you start or stop the MC Historian service.

If you are using MC Historian Standard Edition, the stoplight will start or stop the high-speed, in-process version of the MC Historian Logger and Collector. If you are using MC Historian Enterprise Edition, by default the stoplight will start or stop the OPC-UA-based MC Historian Logger and Collector, which allow for remote data collection and redundancy support.

Users of the Enterprise Edition also have the option of running the In Process version of the Logger and Collector, if redundancy and remote data collection are not required.
Configuring the MC Historian Logger to AutoStart

From within the Workbench, select the MCTray button or icon. Expand the localhost, then expand Services. Then select the Collector for the machine.

Next, select Automatic from the Startup Type drop-down list, as shown below. Other available options are Manual and Disabled. Below the drop-down list is the Service Status which can be in either Started mode, along with a green light indicator, or Stopped mode with red light indicator.

You have the option of changing the Service Status condition to either Start or Stop.

3.3.2 Viewing Licensing Information

In the MC Historian Workbench, you can see the License Viewer by clicking File > Tools > Licensing. The License Viewer tab then appears in the Workbench.
3.3.3 Using TraceWorX

To enable TraceWorX, select File > Tools > TraceWorX. You can then select trace levels for each of the available modules. The TraceWorX tab appears, as shown below.

3.3.4 Configuring TraceWorX

To configure TraceWorX, select the trace level for the intended module. There are several trace levels, show in the image below.
3.3.5 Viewing TraceWorX Generated Log Files

To view TraceWorX generated log files, go to the Current Log tab by clicking the button in the Current Log column and selecting View Log. A separate window opens showing the log files that are contained in that module.
3.4 Initial MC Historian Setup

Before using the MC Historian for the first time, you should use the System Administration/System Settings screen to set:

- The Logging Server Storage Path
- The Archive Settings

The Logger Server storage path is the location where the MC Historian stores the plant data it collects. The default folder for the Logging Server storage path is C:\Program Files\MELSOFT\MC Works64\Components\HHLogger\BaseLogger.1\Data Folder.

It is important to change this default path, especially if the C: drive has a low amount free storage space.

The Archive settings tell the MC Historian whether it is to automatically detach older data from the system, and if it is to remove the old data, the folder location it should move this data to.

The rest of the system settings have default values that facilitate the initial start-up and operation of the MC Historian. For more information on the other settings, refer to “Configuring System Settings” on page 3-51 of this guide.
3.5 MC Historian Tag Organization

The following figure provides an overview of how tags are grouped and organized in MC Historian.

The primary element for the grouping of tags is the *logger*. For each logger that is created, MC Historian creates a series of similarly named binary files to hold the plant historical data. The file creation and automatic archiving functions are based on the logger. You may create multiple loggers.

Before you begin, analyze the data you want to collect and how long you want the data to be kept online in MC Historian. Data that is kept online for longer periods of time should be grouped together in one logger. Data that is to be kept online for shorter periods of time should be grouped in a second logger, and so on. For example, if you want to have some data kept online for a year, some data for three months, and some for one month, you should create at least three loggers; one for each of the desired time ranges.

Loggers are made up of one or more *logging groups*. Each logging group may contain one or more *collector groups* and/or *aggregate groups*. The collector and aggregate groups are made up of *tags*, whose data is to be logged.
Note: Logging groups can be enabled or disabled using the Configurator, and can be enabled or disabled online as well.

3.6 Configuring a MC Historian Logger

A MC Historian logger can be defined to be either File Based or Memory Persistent. If the logger is File Based, all of its collected plant data is committed to the hard disk. If the logger is Memory Persistent, the collected plant data is stored in RAM memory and discarded after a pre-configured amount of time. The Memory Persistent logger can be configured to store a portion of its collected data to the hard disk upon a condition (occurring in real time). An example of each type of logger is included in the default MC Historian configuration (listed under the Loggers selection).

To add a new logger, right-click the Loggers selection and select + Logger. This opens the New Logger tab where you can select the Logger Type of: Disk Logger (File-Based) or Memory Persistent Logger.

Each Logger creates a data file on the hard drive to store the collected plant data. The data file is created for Memory Persistent loggers as well as for File Based loggers because of the feature that permits Memory Persistent logged data to be stored on the disk upon a condition. Each type is described on the pages that follow.

The Unified Data Manager (UDM) can be used to schedule the creation and closing of files based on calendar (date) and Time of Day. In addition, the UDM can be used to trigger file closure based on an external event. To use a UDM trigger to schedule or trigger the file creation, browse for the UDM triggers using the ellipsis button [...] on the right side or type in the specific trigger name.

For more information on the Unified Data Manager, see “Configuring a UDM Trigger” on page 3-43 of this guide.
3.6.1 Disk File Logger

If you choose to create a Disk File Logger, you will need to specify the conditions for when the MC Historian should create a new data file and close the current, existing file. This is used to control the amount of plant data or the time frame for the plant data that should be logged to each file. The conditions can be based on a time period, file size or a Unified Data Manager triggered event.

Refer to the MC Historian online Help for information about how to configure a Disk Logger and set up archiving for it.
3.6.2 Memory Persistent Logger

If you choose to create a Memory Persistent Logger, you will need to specify:

- The time period the collected data is to be kept in RAM memory
- The pre-and post-condition time period the data is to be saved to disk on condition, if the Save Data while Condition is Set feature is enabled
- The conditions under which the MC Historian is to create a new data file and close the current, existing file. The conditions can be based on a time period, file size or a Unified Data Manager triggered event.

Refer to the MC Historian online help for information about how to configure a Memory Persistent Logger and set up archiving for it.
3.6.3 Deleting a MC Historian Logger

Before deleting a MC Historian Logger, you should first verify that there are no Logger Groups using the Logger that is to be deleted. If any Logger Groups are assigned to the Logger, they need to be deleted or assigned to another Logger first.

Once you delete a Logger, the data that was previously logged as part of the group will no longer be available for playback in the trend display nor in the SQL Query Interface.

To delete a logger, right-click it, and then select Delete from the menu. You will see a confirmation dialog box prompting you to proceed.

3.6.4 Managing Data Storage

Backing Up the MC Historian Configuration Database

It is highly recommended that you back up all of the MC Historian and SQL databases:

- Before you make any changes to the database, in case you want to return to the original configuration.

- On a regular schedule, to minimize data loss in the event of a disk failure. The best way to perform database backups is to set up automatic backups using SQL Server Management Studio. You should back up your database at least once a week.

When you perform a database backup, all system tables, user-defined objects and data are copied to a separate file located on a backup device. Backup devices include disk files, floppy diskettes, zip disks, and tape drives. Backups can be easily managed using the SQL Server Management Studio. The master and msdb databases should be on the same backup schedule as the Runtime database.
MC Historian Configuration

Backing Up the Database

Note: Any transactions that are in progress when the backup is performed are rolled back if that backup is later restored.

To back up the database

1. In Microsoft SQL Server Management Studio, expand Databases and select MC Historian.

2. Right-click the MC Historian database, point to Tasks, and then click Back Up…. The SQL Server Backup dialog box appears.

3. Click the General tab. In the Database box, select MC Historian.

4. To use an existing backup device or file for the backup, select the destination in the Destination area and then click OK to begin the backup.

For details on a particular backup destination, select the destination in the list and then click Contents.
5. If you do not have a backup destination defined, click **Add** to add a new destination. The **Select Backup Destination** dialog box appears.

6. Select to back up to either a file or device.
   - To back up to a **file**, type or browse to a path for the location of the backup file. Be sure that you have enough free disk space to store the backup.
   - To back up to a backup device, select an existing backup device or select **<New Backup Device>**. The **Backup Device Properties** dialog box appears. In the **File name** box, type a name for the device. As you type the name, the path for the backup will be modified. Verify that the path for the backup is correct. When you are done, click **OK** to create the backup device.

7. Click **OK** to close the **Select Backup Destination** dialog box.

8. The newly-created backup device now appears in the **Destination** window of the **SQL Server Backup** dialog box. Select the new backup device.

9. Click **OK** to perform the backup.
   
   You can configure various options for database backups, such as an expiration date for a backup. You can also schedule automatic backups.

   For a complete description of database backup and restoration using SQL Server Management Studio, including scheduling recommendations and transaction log backup, see your SQL Server Management Studio documentation.
3.7 Configuring a MC Historian Logging Group

To edit or add a new MC Historian Logging Group:

1. Right-click the Groups icon in the MC Historian Configuration tree and click **+Logging Group** to add a Logging Group.
2. Enter the **name** of the Logging Group.
3. Ensure the **Enabled** checkbox is checked.
4. Select the Logger that this Logging Group is to belong to from the **Select Logger** drop-down list.
5. If you wish to set a **Collecting Condition**, click the **Collect On Condition** checkbox. The condition can be based on a Unified Data Manager trigger. To select a UDM conditional trigger, browse for the trigger by clicking the ellipsis button [...] on the right side, or type in the trigger name.
6. Click the **Apply** button.

If the **Collector overwrites Source Timestamp of data with its actual UTC time** is checked, the MC Historian logger applies its own time stamps to the collected data instead of using the time stamps provided by the OPC Server. This feature can be used if the OPC Server cannot provide accurate or reliable time stamps.
The **Aggregation** folder is automatically created in the logging group's tree. For a description of its use, see the descriptions of aggregate groups and tags, later in this document.

### 3.8 Configuring a MC Historian Collector Group

To edit or add a new MC Historian Collector Group:

1. Right-click the Logging Group icon in the MC Historian Configuration tree that the Collector is to belong to, and click **+ Collector Group** to add a Collector Group.
2. Enter the name of the Collector Group.
3. Select the Collector from which this Collector Group is to get its data from the drop-down list.
4. Specify the Data collection rate. The data collection rate is the rate at which the Collector collects the raw data samples from the data source.
5. Specify the Calculation period. The Calculation period is the frequency of which the Collector is to perform its Advanced Filtering calculations for the tags within this group. (For more information on the Calculation period, see “Log to Disk Configuration” on page 3-19).
6. Enter the Description of the Collector Group.
7. Click the **Apply** button to save the changes.

Note: If the **Override parent logging group timestamp settings** and **Collector overwrites SourceTimestamp of data with its actual UTC time** options are checked, the MC Historian collector will apply its own time stamps to the collected data instead of using the time stamps provided by the OPC Server. It could be used if the OPC Server cannot provide accurate or reliable time stamps.

The **Refresh** button refreshes the screen with the current configuration settings for the collector group by reading it from configuration database.

Once the Collector Group has been created, you can access further options by right-clicking the group in the left-side navigation pane.

In addition to the standard options including Edit, Rename, Delete, Paste, Cut, Copy, Multiply, Refresh or Refresh Parent, you can now create a new MC Historian Folder or MC Historian Tag.
3.9 Configuring a MC Historian Tag

To edit or add a new MC Historian tag to collect data from a signal:

1. In the Data Collections section of the MC Historian Project Explorer, right-click the Collector Group or the Tag Folder and click + Tag to add a tag. This opens the New Tag tab.

Alternatively, you can create several tags at once by selecting + Multiple Tags, which opens the Data Browser where you can select multiple tags to be added as MC Historian tags.

2. Enter a name for the tag.

3. Select the signal to be logged by clicking the ellipsis button [...] to the right of the Signal Name field and browsing for the tag whose data is to be logged.

4. Enter a Description for the tag.

5. Enter the Engineering Units.

6. Click the Support Operator Comments to enable this feature if it is desired.

7. Select the Data Type from the next drop-down list. Options include: Native, Boolean, Int8, UInt8, Int16, UInt16, Int32, UInt32, Int64, UInt64, Float32, Float64, String, DateTime, and Duration.

Note: MC Historian requests the selected data type from the data source (that is, the OPC server). The UInt64 and Float64 data types are not supported by OPC DA Servers running on Windows 2000.
8. Select the **Stepped Interpretation** option if desired.

9. Enter the ranges for the **Hi Limit** and **Lo Limit** in the provided text entry fields. Note, these limits are used by the filter algorithms. For more information, see the “Deadband Filter Configuration” and “Swinging Door Filter Configuration” sections (on page 3-20) for information on how the limits are used.

10. If desired, apply **Filtering** to the tag by selecting either **Deadband** or **Swinging Door**.

11. If you enabled a **Deadband** filter, select the type of deadband filter to be used (Absolute or Percentage) and enter the filter setting.

12. If you enabled a **Swinging Door** filter, select the **Filter Enabled**, enter the additional settings.
13. Open the **Tag Logging Options** tab of the dialog and select the **Log to Disk** option. You can request that all collected raw samples be logged, or you can alternatively request the MC Historian to perform an advanced filter. The Advanced Filter options include Moving Minimum, Moving Average and Most Recent On Time. If you choose an advanced filter such as the Moving Average, the MC Historian collector will perform the Moving Average calculation on the raw samples over the defined calculation period (defined when setting up the Collector for the tag). The result of the calculation will be logged at the end of each calculation period.

14. The Tag Aggregates tab is described later in this section where aggregate folders and aggregate tags are described. For information about the **Tag Logging Options** tab, refer to the MC Historian online Help.

15. Click the **Apply** button to save the changes.

### 3.9.1 Log to Disk Configuration

The Log to Disk configuration allows you to specify if all samples collected by the Collector are to be logged or if the collector is to perform an advanced filter on the samples instead. The Advanced filter options include:

- All Samples
- Maximum
- Minimum
- Average
- Standard Deviation
- Totalizer
- Running Maximum
- Running Minimum
- Running Average
- Moving Maximum
- Moving Minimum
- Moving Average
- Most Recent On Time

The calculation period for the Advanced filter is specified in Collector group configuration.
3.9.2 Deadband Filter Configuration

The Deadband filter is performed by the Collector on incoming data. It serves as the front-line for all of the filtering logic. The deadband filters out values based on difference of values of consequent changes – if the difference is below defined threshold, new value is ignored.

Parameters:

Deadband configuration is straightforward:
- It can be either disabled or enabled
- If enabled, it is possible to configure its range
  - As an absolute value (non-negative)
  - As a percentage of value range (max - min) defined for the tag
  - Note that the value configured is the minimum difference between values to allow subsequent values to become a “base value” for deadband ranges. Actual range around base value spans both up and down (see the example below).

Example:
3.9.3 **Swinging Door Filter Configuration**

The Swinging Door filter is a generalization of a deadband filter. It is implemented by the Logger on incoming values it receives from the Collector. It serves as the last-line of the filtering logic. The swinging door filters off values based on difference of consequent values from linear trend – if the difference is below defined threshold, any new values are ignored.

**Detailed operation**

Swinging door filters values that follow certain linear trends. It starts with one value (the first one is always forwarded to storage).

Two tangents are considered, originating above and below the base value in a defined filter range. Tangents are effectively defined by second value in filter (see the example on page 3-23). As the Logger processes subsequent values, the tangents are adjusted to form a geometrical region encompassing all values in filter so far.

Geometrically, as long as tangents don't intersect prior to the base value (i.e. the region defined by tangents is not broadening – hence the commonly used filter name), the filter is valid. When new value causes the region to open up, the filter is flushed – the last value prior to breaking one is dumped to storage and the filter is reinitialized using that value and the breaking one.

There are certain guarantees about the maximum deviation of filtered values (the difference of ignored values from the stored trend can't be higher than the distance between points used to draw tangents above and below the base point, for example).
**Parameters:** Filter configuration is similar to deadband's:
- It can be either disabled or enabled
- If enabled, it is possible to configure its range
  - As an absolute value (non-negative)
  - As a percentage of value range (max - min) defined for the tag

Besides these parameters, there are two additional ones:
- Minimum distance between values
  - If two subsequent values are closer (time-wise) than defined threshold, the new value is ignored
- Maximum distance of values
  - If the distance between the last stored value (physically) and an incoming value is higher (time-wise) than defined threshold, the filter is flushed as if the new value would be one to break the filter.
Example:

Green lines mark current bounds

Swinging door range

This value is stored

Blue line marks previous bound – with each new value, zero or one of bounds changes to adjust value range

Red line marks new range that breaks filter. Last value before break is put to output and filter starts anew based on last and current value

This value is stored
Calculated Tags

In MC Historian, you can use calculated tags and calculation triggers to configure complex calculations. You can use performance calculations to provide totals over time, or statistics for analysis. These calculations are performed only on historical data stored in MC Historian. You can also use these calculations for setting up alarms or faults for certain conditions that may occur over time.

For example, you may want to schedule maintenance for a machine every 10,000 hours of run time or every 1,000 cycles. In this case, you can create a calculation tag that calculates the amount of time the tag is in the TRUE state, and another calculation tag that counts the number of times the machine has been switched on. A third calculation tag can monitor the incoming values for the first two tags, and can generate an alarm when a predetermined threshold has been reached for maintenance.

Performance calculations can be triggered periodically or on any data change event, using a flexible new date/time and many different mathematical, string and historical data retrieval functions that are part of the Expression Editor. Calculations can use scalar values, historical values, or string operations, along with a wide variety of functions within an enhanced version of the Expression Engine, and results are calculated automatically on each trigger, or can be recalculated manually on demand.

Calculated tags take as their input normal incoming values from MC Historian tags and perform calculations on historical data. The results of these calculations are stored in the MC Historian database. You can nest calculated tags so that they can be used as input to other calculated tags. These calculations are triggered using calculation triggers -- these are triggers that are created specifically for use with calculated tags. Calculation triggers are different than regular triggers because they can point to historical dates and times, whereas regular triggers cannot. Calculation triggers also make use of special functions that are available only to them, for use with calculation tags.
Configuration of a new Performance Calculation tag is easy. Simply add a new Calculated Tag in the existing hierarchical structure of the MC Historian Workbench configurator; you can organize calculated tags in folders and subfolders. Each Performance Calculation appears as a new tag in the MC Historian browser, and can therefore be accessed, replayed, analyzed, and reported on just like other MC Historian data values.

MC Historian offers several preconfigured calculations out-of-the-box such as standard deviation and variance, and you can customize your own Performance Calculations using the Expression Editor, with equation parsing and syntax checking.

To configure calculated tags you must do the following:

- Add calculated tags to the folders where you store your MC Historian tags.

- Create calculation triggers that will execute the calculations, and add these triggers to your calculated tags.

- Set up recalculation options in the System Administration node.

### 3.9.4 Configuring a Calculated Tag

To create a calculated tag in MC Historian, follow the steps on the following pages. Each calculated tag that you create will store calculated values in the MC Historian database. You will be creating the calculated tag in the folder where the MC Historian tags you will be using as input are located. This is for organizational purposes only. The calculated tags that you create can reside anywhere in the Data Collections node. In fact, you can put them into a folder of their own if you like.
1. In the Workbench, make sure you are looking at the MC Historian provider. Expand the Data Collections node so that you are in the folder where you want to create the calculated tag.

2. Right-click the folder where would like to add a new calculated tag, and select **Calculated Tag**, as shown below. This opens the Calculated Tag window with the Properties tab on top.

3. In the MC Historian Calculated Tag form that opens (shown in the following figure), enter a name and display name for the calculated tag.
Leave the **Enabled** checkbox unselected until you are ready to begin using the calculated tag. Enter a description that describes how the calculation is used; include information that will be helpful for later maintenance of the tag.

4. You can optionally put a check mark in the **Support Operator Annotations** check box to allow operators to comment on the signal in displays. Later, as the tag's data values play or replay in the Trend Viewer, you may want to be able annotate the tag's data values as you see them trending before you. For example, you may want to note an operator action that altered the data slightly, or highlight a piece of data for analysis later. Putting a check mark in the Support Operator Annotations check box allows you to do that. Such annotations are saved with the tag's data in its logger file, which makes the annotations available in a replay, accessible to the MC Historian SQL Server Interface, and archived with the tag's data.
5. Select the data type from the **Data Type** drop-down menu. Among the options available to you are: Native, Boolean, Int8, UInt8, Int16, UInt16, Int32, UInt32, Int64, UInt64, Float32, Float64, String, DateTime, and Duration.

6. Specify the **minimum** amount of time between samples. This option is helpful for limiting samples from high-frequency sampling.

7. Enter the **engineering units**.

8. Put a check mark next to **Stepped interpretation** to enable this feature if it is desired. The Stepped Interpretation check box is used primarily during playback, for interpreting the tag's data values. This feature is applied only if you request a value for a certain point of time. The returned value will be the nearest older value available. In general, if the data comes from a discrete signal such as an on/off switch (or a Boolean data type), put a check mark in this box; but if data comes from a sine wave or analog signal, leave the box empty.

9. Enter the **ranges** for the Lo Limit and Hi Limit. The high and low limits are used by the filter algorithms.

10. In the **Trigger** section, add the triggers that determine when the calculations will occur. The triggers that you can add here are calculation triggers that must be predefined as described in the “Creating a Calculation Trigger” topic that follows. Note that you can use the **Up** and **Down** buttons (on the right) to sequence triggers in the list. The sequence becomes important only when two triggers execute at the same time; the trigger that is higher in the list will execute first.
11. Now go to the Expression tab to create an expression for the calculation. This expression should include the following:

- The **tag or tags** whose data is to be used as input to the calculation. This can include values from MC Historian tags and signals as well as values from other calculated tags. Clicking the **Variables** button will open a dialog box that lets you choose any tag that is in the MC Historian tree in Project Explorer.

- The **historical time frame** from which data is to be taken. The time frame should be relative to the execution date and time determined by the triggers. Do not hard code dates into the expression unless you always want those exact dates to be used for the calculation.

- Any **additional selection criteria** to be used.

- The **calculation** to be performed. Click the **Arithmetic**, **Relational**, **Logical**, **Bitwise**, and **Functions** buttons to incorporate syntactically correct elements into the calculation. Note that a number of functions that are specific to calculated tag logic have been developed for use.
12. Click the Syntax button at the bottom of the window to check the logical syntax of the expression. Make any necessary corrections.

13. When you are satisfied with the calculation, make sure you put a check mark in the Enabled check box.

14. Click Apply when you are done.

15. At this point you can test the calculated tag to make sure the expression is calculating the result you are looking for.
3.9.5 Creating a Calculation Trigger

In MC Historian, you create calculation triggers that cause the Performance Calculation Engine to evaluate calculated tags. (For more about calculated tags and their use, refer to the previous Calculated Tags topic.) Once you have created a calculation trigger, you can add it to the calculation tags for which it will execute calculations.

Calculation triggers are much like regular Unified Data Manager (UDM) triggers except that they are designed to work with historical data. This topic describes how to create time triggers and data triggers for use with MC Historian calculated tags.

As you can see in the figure below, calculation triggers get their own Calculation Triggers node in the MC Historian tree structure in the Workbench Project Explorer. This is where you will create and store the calculation triggers that you create for executing calculations for calculated tags. In the Calculation Triggers node, notice that Time triggers are identified with a clock icon, and data triggers with a "X=" icon. This topic describes Time Triggers for Calculated Tags and Data Triggers for Calculated Tags.
3.10 Time Triggers for Calculated Tags

A time trigger defines specific times at which the trigger is to fire. When you add a time trigger to a calculated tag, the tag's calculations fire at the times indicated by the time trigger. The calculated tag can have any number of triggers associated with it, but a trigger must be enabled in order to fire. If it is not enabled, it won't fire.

To create a time trigger for calculated tags in MC Historian, follow these steps:

1. In the MC Historian Project Explorer in the Workbench, expand the tree so you can see the Calculation Triggers node.

2. Right-click the Calculation Triggers node and select + Time Trigger. The MC Historian Time Trigger form opens, as shown below.

![MC Historian Time Trigger form](image)

- **Name:** 10s
- **Display Name:** Period 10s
- **Time zone:** Use local server time
- **Recurrence type:** Time interval
- **Starting at:** Tuesday, 18 September 2012 17:17:31
- **Recur every:** Days 0, Hours 0, Minutes 0, Seconds 10

---

**Properties**

- **Description:**

**Processing Phase:**

- **Time Trigger Options**

---

**MC Historian Configuration**

---

**MITSUBISHI ELECTRIC**

3-32
3. Enter a name and display name. Enter a description that aptly describes the trigger and how it is used.

4. Enter a **Processing Phase**, which determines this trigger's relative priority in the event that multiple triggers are activated at the same time.

5. Specify whether the trigger runs based on **UTC** time or **local** time on the server.

6. For the **Recurrence Type**, specify whether you want the trigger to run at a specified **Time Interval**, or on **Specific Dates and Times**. For more information, refer to the **Time Trigger Options** topic for the UDM.

7. Click the **Preview** button to see a display of the exact times at which the time trigger will fire. Previewing the times is helpful if you are configuring a complex recurrence pattern; it can help you to understand whether you have configured it properly or not.

8. When you are done, click **Apply**.

9. Now you can associate the trigger with a calculated tag as described in the process for “Configuring a Calculated Tag” above.
3.11 Data Triggers for Calculated Tags

When you add a data trigger to a calculated tag, the tag’s calculations fire when the value of a data point equals a specified value or condition. For example, it can fire when a machine switch gets set to on, or TRUE. A calculated tag can have any number of triggers associated with it, but a trigger must be enabled in order to fire. If it is not enabled, it won't fire.

To create a data trigger for calculated tags in MC Historian, follow these steps:

1. In the MC Historian Project Explorer in the Workbench, expand the tree so you can see the Calculation Triggers node.

2. Right-click the Calculation Triggers node and select + Data Trigger. The MC Historian Time Trigger form opens, as shown below.
3. Enter a name and display name. Enter a description that aptly describes the trigger and how it is used.

4. Enter a Processing Phase, which determines this trigger's relative priority in the event that multiple triggers are activated at the same time.

5. In the Trigger On drop-down list, choose the condition in which the trigger is to fire. The trigger can fire upon **Any Datapoint Change** or using an **Expression** in which you can specify any condition to execute the trigger. For more information about creating an expression that fires, refer to the “Expression Editor” topic in your MC Historian online help documentation.

6. In the Data point field, specify the tag for the data point to be tested for the trigger.

7. Specify whether you want to Ignore Bad or Uncertain quality tags.

8. When you are done, click **Apply**.

9. Now you can associate the trigger with a calculated tag as described in the process for “Configuring a Calculated Tag” above.

### 3.11.1 Organizing Tags into Folders

A MC Historian folder can be useful to gather individual MC Historian Tags. To add a new folder:

1. Right-click a Collector Group and select **+ Folder**.
2. Enter a name in the text entry field and a description.
3. Click **Apply** or **Refresh** to proceed.

You can now create a MC Historian tag on the same level of the Collector Group or within a newly created MC Historian folder. Right-click either a collector group or a MC Historian folder and select **Tag** to proceed.
3.12 Configuring a MC Historian Aggregate Group

In this version of MC Historian, an aggregate group represents an interval for collecting data from one or more OPC tags in a logging group. For example, you may have a logging group for which you want to collect data every 2 minutes, every 30 minutes, every 12 hours, at the end of each day, and at the end of each week – so you would create an aggregate group for each of these time intervals.

To edit or add a new MC Historian Aggregate Group:

1. To add an Aggregate Group, navigate to the Groups area in the MC Historian Project Explorer, right-click the Logging Group's Aggregation, then click +Aggregate Group.

2. Enter the name of the Aggregate Group.

3. Specify the Calculation Period. The calculation period is the interval at which the MC Historian Logger is to perform the aggregate calculation.

4. Specify the Percent Good amount that the data must satisfy for the aggregate to be considered “good,” as well.

5. Decide whether you want to treat uncertain data points as bad.

6. Enter a Description of the Aggregate Group.

7. Click the Apply button to save the changes.
3.13 Configuring a MC Historian Aggregate Tag

Note: Aggregate tags have changed in this version of MC Historian.

3.13.1 Behavior of Aggregate Tags

MC Historian provides functionality to evaluate OPC HDA aggregates of managed tag data on the fly – each such configured evaluation is called aggregate tag. An aggregate tag is defined in the tag configurator using the Tag Aggregates tab; here you simply define the aggregate groups to be used for an OPC tag. (Aggregate tags no longer appear as nodes in the navigation tree.)

The aggregate tag's name is generated automatically, using the aggregate evaluation properties (the name of aggregation type and the sampling rate) that you define for it. The aggregate name abbreviates these properties, so a longer, more descriptive Display Name is available, too.

When a new aggregate tag is defined, its values may get evaluated backwards as well, depending on the value of ancestor sampling group's property “recalculate all”; however, changing the property value has no effect on currently defined tags.

You have the option of disabling an existing aggregate tag's evaluation so that its value changes are ignored. Note that a disabled aggregate tag can be re-enabled again at any time.

Evaluation of Sampled Data

The Aggregate Tag evaluation runs in the background independently and its results are stored in the MC Historian logger based on the parameters defined for it. The evaluation abides to simple rules:
Evaluation logic monitors incoming data values and reevaluates aggregates whose values might change as a result of changed source data.

- The evaluation is performed periodically on specified time intervals where data is detected as changed since the last evaluation; the initial evaluation of an interval occurs with at least a 1 minute delay.

- Sampling intervals are aligned to the nearest earlier occurrence of the nearest higher time bin boundary. For example, a sampling rate of seconds yields sampling intervals aligned to a minute – having a sampling rate of 5 seconds yields intervals starting at +0, +5, +10...+55 seconds within a minute.

- Note, however, that sampling rate value that is not a divisor of the given time bin may yield anomalies in sampling interval alignment during re-evaluations. For that reason, you should restrict available sampling rates to divisors.

### 3.13.2 Aggregate Tag Configuration

To edit or add a new MC Historian Aggregate Tag:

1. Double-click the MC Historian tag for which you want to define aggregates. The tag’s configurator opens.

2. Select the Tag Aggregates tab. Here you can define any number of aggregates to be collected for the MC Historian tag. For each aggregate, specify the information described in the steps that follow. Note that an informative Aggregate Name and longer Display Name are generated for you automatically.

3. Select the Enabled check box to collect data for the aggregate.
4. Select the **Aggregate Type**. The following types of aggregates are supported by the MC Historian:

- Interpolative
- Average
- Time Average (Interpolated Bounds)
- Time Average
- Sum
- Total (Interpolated Bounds)
- Total
- Minimum
- Maximum
- Minimum Actual Time
- Maximum Actual Time
- Range
- Minimum (Bounds)
- Maximum (Bounds)
- Minimum Actual Time (Bounds)
- Maximum Actual Time (Bounds)
- Range (Bounds)
- Count
- Number of Transitions
- Start
- End
- Delta
- Start (Bounds)
- End (Bounds)
- Delta (Bounds)
- Duration Good
- Duration Bad
- Percent Good
- Percent Bad
- Worst Quality
- Worst Quality (Bounds)
- Annotation Count
- Standard Deviation (N-1)
- Variance (N-1)
- Standard Deviation (N)
- Variance (N)
5. Select the **Aggregate Group** that has the calculation interval you want to use for the aggregation. If you don't see the group you are looking for in the drop-down list, click the **Refresh Aggregate Groups** button, then try again.

6. You can optionally set an override (in hours, minutes, and seconds). To do so, put a check mark in the **Override Sample** check box. Then in the **Sampling Rate** column, click in the field to enable the [...] ellipsis button. Then click the ellipsis button to bring up a secondary box, allowing you to change the hours, minutes, and/or seconds.

7. Click the **Apply** button to save the changes.

### 3.14 SPC Configuration in MC Historian

For AX Quality customers, SPC configuration is included in your installation of MC Historian. This enables you to configure rules and tags related to SPC charts that monitor the capability and reliability of your system. You first configure rules that you then apply to specific tags that you configure for display in SPC and histogram charts.

For more in-depth instructions regarding the configuration of SPC distribution rule sets and tags, consult your online documentation for MC Historian or AX Quality.

**Configuring SPC Distribution Rules**

To configure an SPC distribution rule in MC Historian:

1. Navigate to the SPC Distribution Rules area of the MC Historian Project Explorer.

2. Right-click the “SPC Distribution Rules” folder and select **+ SPC Distribution Rule Set**.

3. Enter a name and a description for the rule set.

4. In the **Rules** area, click the “Enabled” check box to add a rule to the rule set.
5. Specify one of the following rule types:
   a. Outside Sigma Limit
   b. Outside Upper Sigma Limit
   c. Outside Lower Sigma Limit
   d. Outside Sigma Limit Single Side
   e. Trending
   f. Trending Up
   g. Trending Down
   h. One Side Of Center Line
   i. Above Center Line
   j. Below Center Line
   k. Within Sigma Limit
   l. Alternating
   m. Alternating Lower Sigma Limit

6. Enter a number of total values, a violation count, and sigma total (NSigma) associated with your rule.

7. Press the Up and Down arrow buttons to adjust the relative priority of the rules in the rule set. Rules appearing closer to the top of the chart receive higher priority.
Configuring SPC Tags

To configure a tag for use in SPC charts and reports:

1. Navigate to the Data Collections area in the MC Historian Project Explorer.
2. Right-click the folder that should contain the SPC tag and select + SPC Tag.
3. Give the SPC tag a name, an optional display name, and a description.
4. In the Properties tab, select the logging group and data source that should be associated with this SPC tag.
5. In the Properties tab, select the SPC distribution rule set that this tag should follow.
6. In the Properties tab, select the summary statistics Collection Type for the tag.
7. In the Properties tab, set the Hi Limit and Lo Limit for the chart displaying data from this tag.
8. In the Properties tab, specify any triggers that, when activated, cause the tag to associate incoming data from the data source with a new group of values.
9. In the Control Limits tab, specify whether the control limits associated with this tag should be constant values or based on the tag’s data.
10. In the Statistics tab, specify the types of summary statistics that MC Historian should calculate for this SPC tag.
3.15 Configuring a UDM Trigger

Starting the Unified Data Manager (UDM)

If you already have a component running with Workbench, click the down-arrow in the bottom right corner of the Project Explorer navigation menu and select Unified Data Manager.
Creating a UDM Trigger

To create a new trigger within the Unified Data Manager, expand the Triggers selection (next to the lightning bolt icon) to show the Data Triggers and Time Triggers options.

3.15.1 Configuring a Data Trigger

1. To add a new Data Trigger, right-click Data Trigger and then click + Data Trigger.
2. Ensure the Enabled checkbox is checked.
3. Enter the Name for the trigger.
4. On the Basic tab, enter the optional Description.
5. On the Basic tab, select the Trigger type. The following types are supported:
   • On any data change (event)
   • When data tag changes to TRUE
   • When data tag changes to FALSE
   • While data tag is TRUE
   • While data tag is FALSE
6. On the Basic tab, select the data tag that is to be monitored and used as the basis for the trigger. You can browse for the tag or type in (or copy in) the tag name.
7. On the Advanced tab, enter any of the optional advanced trigger conditions, as desired or needed. The (optional) advanced conditions include:
   • Time zone (either local server time or UTC)
   • Start time for monitoring the data tag
   • Stop time for monitoring the data tag
   • Trigger delay
   • Trigger repeat function
   • Trigger enable tag (the trigger is active only when this tag is TRUE)
8. Click the **Apply** button to save the changes.

![Image](image.png)

### 3.15.2 Configuring a Time Trigger

1. To add a new Time Trigger, right-click **Time Trigger** and then click **+ Time Trigger**.
2. Enter the Name for the trigger.
3. Ensure the Enabled checkbox is checked.
4. On the **Basic** tab, you may enter an optional Description.
5. On the **Basic** tab, select whether or not the time trigger is to be a condition or an event. If it is a condition, the Trigger tag will remain TRUE for the specified duration time.
6. On the **Basic** tab, select the Recurrence type. The types include:
   - One time only
   - Time interval
   - Specific dates and times
7. If the Recurrence type is **One time only**, select the date and time the trigger is to occur.
8. If the Recurrence type is **Time Interval**, select the starting date and time, and the Recur interval.
9. If the Recurrence type is **Specific dates and times**, select the Recur interval. Note, depending on the units selected for the Recur interval, you will be prompted with different Recurrence details to enter.
10. On the **Advanced** tab, enter any of the optional advanced trigger conditions, as desired or needed. The (optional) advanced conditions include:
   - Time zone (either local server time or UTC)
   - Stop time for the Time Trigger execution
   - Trigger delay
   - Advance notification
   - Trigger enable tag (the trigger is active only when this tag is TRUE)
11. Click the **Apply** button to save the changes.

3.16 Node Setup and Redundancy

The MC Historian installation initializes the Node Setup and Redundancy configuration. Its default settings are for a non-redundant single workstation setup (that is, a non-redundant MC Historian logger with one local collector).

Use the Node Setup and Redundancy configuration to perform any of the following changes:

- Change the name or description of a collector or logger
- Add or delete remote collector(s) (Enterprise Edition)
- Specify the redundancy settings for a collector (Enterprise Edition)
- Specify the redundancy settings for a logging server (Enterprise Edition).
- Set up Store and Forward to cache and forward data if the connection to a collector is lost (Enterprise Edition).
3.16.1 Configuring a Collector Node

1. To add a collector, right-click the Node Setup and Redundancy icon and select + Collector.
   **Note:** If you want to edit an existing collector, double-click the icon of the existing collector.

2. Enter the name for the Collector

3. Ensure the Enabled checkbox is checked.

4. Enter an optional description, if desired.

5. Specify information for the Store and Forward feature. This feature caches data if the connection to a collector is lost. When the connection to the collector is restored, the cache will be flushed, and the two (primary and secondary) databases will be automatically synchronized. Options are:
   - The report event interval (in hours/minutes/seconds)
   - Your discard policy (Discard oldest data first OR Discard newest data first)
   - The maximum storage size in megabytes
   - The percentage of the maximum size at which a warning is given
   - If you want the most recently collected data to be stored and forwarded before all other data, put a checkmark next to Send Most Recent Data first.

6. Next, select one of the following:
   - Select In-Process Collector if you have installed one collector that resides on the same server as the logger. Click Apply to save your changes. Proceed to the next section, “Configuring the Logging Server” on page 3-49.
   - Select Standalone Collector if you have the Enterprise edition of MC Historian and one or more separate standalone collectors have been installed, then follow the remaining steps, below the figure.
7. From the Protocol drop-down list select either HTTP or TCP.

8. Enter a name for the Primary Node or select one from the drop-down list. The URL field below it will be pre-filled from your primary node selection. (To modify the URL, see step 12.)

9. Now you have the option to create a backup node by putting a check mark next to Secondary Node. The remaining steps assume you have proceeded with configuring a backup node.

10. Enter a name for the secondary node or select one from the drop-down list. The URL field below it will be pre-filled from your backup node selection. (To modify the URL, see step 12.)

11. Click the checkbox next to Auto Fail-back to switch from the secondary node to the primary node when the primary becomes active again.
12. Click the checkbox next to **Use advanced configuration** to allow further configuration. Once the box is checked, you can click on the **Advanced Configuration** button at the bottom of the window to open the Advanced Redundancy Configuration window, where you can modify the Primary Node URL and/or Secondary Node URL directly. Note that changes to this configuration may require equivalent changes in the nodes configuration. Click **OK** to proceed.

13. Click the **Apply** button to save the changes.

### 3.16.2 Configuring the Logging Server

1. To edit the Logging Server, double-click the icon of the existing Logging Server.

2. Enter the **name** for the Logging Server

3. Ensure the **Enabled** checkbox is checked

4. Enter an optional **description**, if desired.

5. Optionally, to make the server's historical data read-only, put a checkmark in the **Disable HDA Editing** checkbox. If you do this, you won't be able to edit any Historical data being logged on the server using **any** programmatic interfaces.
6. Now you have the option to click the checkmark next to **Redundancy** to enable it. *The following steps assume you have selected to enable Redundancy.*

7. Select your desired Protocol (HTTP or TCP) by using the drop-down list.

8. Enter a name for the **Primary Node** or use the drop-down list to select one. The URL field below will be pre-filled depending on your selected primary node. (To modify the URL, see step 11.)

9. Enter a name for the **Secondary Node** or use the drop-down list to select one. The URL field below will be pre-filled depending on your selected backup (secondary) node. (To modify the URL, see step 11.)

10. Click the checkbox next to **Auto Fail-back** to switch from the secondary node to the primary node when the primary becomes active again.

11. Click the checkbox next to **Use advanced configuration** to allow further configuration. Once the box is checked, you can click on the **Advanced Configuration** button at the bottom of the window to open the Advanced Redundancy Configuration window, where you can modify the Primary Node URL and/or Secondary Node URL directly. Note that changes to this configuration may require equivalent changes in the nodes configuration. Click **OK** to proceed.

12. Click the **Apply** button to save the changes.
3.17 Configuring System Settings

You will need to restart the MC Historian logger after making changes to the system settings. This can be done by clicking the traffic light icon in the top ribbon and waiting for it to turn red (indicating the logger has stopped) and then clicking it a second time to restart the logger.

3.17.1 Configuring License Mode

The MC Historian is available in two major editions, Standard Edition and Enterprise Edition. Both editions support the connectivity, data collection and logging, archiving, and data playback capabilities of the MC Historian. In addition to supporting these core capabilities, the Enterprise edition includes support for remote or standalone distributed data collection, redundancy (both at the collector level and the data logger/database level), store and forward capability, and optimization for multi-core and multi-processor systems.

The Enterprise Edition is optimized for performance in a distributed data collection environment where the data collection is performed on separate machines, not on the PC/workstation running the Logger. The Standard Edition, on the other hand, is optimized for a single PC / workstation system where the entire MC Historian is running on one machine.

The MC Historian Enterprise Edition users can run MC Historian Logger in Enterprise or Standard mode if the MC Historian is running on a single PC/workstation (that is, a non-redundant single workstation). Running the system in Standard mode provides better logging performance and the possibility of achieving high throughput rates on a single PC solution.
In the System Settings, listed under System Administration in the Project Explorer, Enterprise edition users can set the License Mode.

- Selecting the auto mode results in MC Historian using the mode version of MC Historian Logger and Collector that matches the configuration of the collectors (InProc if using local collectors, OPC UA version if using remote collectors). This is the default license mode for Enterprise edition users.
- Selecting the standard mode results in the MC Historian using the InProc version of the MC Historian Logger and Collector, which is optimized for single PC/workstation performance.
- Selecting the Enterprise mode results in the MC Historian using the OPC UA version of the MC Historian Logger and Collector, which is optimized for a distributed system, and one that supports redundancy, store-and-forward, and optimized performance on multi-CPU systems.

It is also important to set the Disk Space Management settings. With these settings, you are able to set:

- The amount of disk space remaining (in megabytes) before you receive a warning
- The amount of disk space remaining (in megabytes) before you receive an error message and the Data Logger stops logging.
3.17.2 Configuring Archive Settings

Use the System Settings for the overall configuration of the MC Historian Archive function. The MC Historian Archive function automatically detaches older data from the system and moves the detached data to a specified location (that is, a specified folder).

After archiving is enabled and the MC Historian has begun creating archived files, the archive files created by the MC Historian should be backed up to CD, DVD, tape, or some other permanent storage media for long term storage.

To open the Archive settings screen, expand System Administration in the Project Explorer, select System Settings and verify the Options tab is displayed. Note the two additional tabs called Memory Persistent Logger and File Logger. Here you can set up archival parameters for your memory-persistent logger or file logger. Each is described separately on the pages that follow.

Archival for Memory Persistent Logger:

To set up archiving for a memory-persistent logger, click the Memory Persistent Logger tab. You can enable archiving by putting a check mark next to Enable Archiving and by specifying the path and folder name for the folder that is to contain the archived (detached) data files.
Before using the MC Historian for the first time, use the System Administration/System Settings screen to set the **Logging Server Storage Path**. The logger server storage path is where MC Historian stores the plant data it collects. The default folder for the Logging Server storage path is is `C:\Program Files\MELSOFT\MC Works64\Components\HHLogger\BaseLogger.1\Data Folder`. 

**It is important to change this default path**, especially if the C: drive has a low amount of free storage space. To change the default path, click the **Browse** button to set your desired Logging Server Storage Path.

You can also specify whether MC Historian is to generate *Metadata* for the archived files. Use the **Tuning** and **Advanced** tabs to further hone your archiving choices. These features are described in online Help.

**Archival for File Logger:**

To archive data from a file logger, click the **File Logger** tab. Use the **Cache**, **Logger**, **Master Logger**, **Logger Data Store**, and **Master Logger Data Store** tabs to fine tune your archiving requirements.
Using the MC Historian Archiving Management

Once the MC Historian's logged data is archived (detached from the system), the data is no longer available for playback on the trend display or available through the SQL Query interface. However, previously archived data can easily be reattached to the system and again made viewable on trend displays and accessible via the SQL Query interface. This is done via the MC Historian Archiving Management screen.

To access the Archiving Management screen, double-click the Archiving Management Icon located under the System Administration Icon in the Project Explorer. Your Archiving Configuration should be pre-filled from the information added within the System Settings.

You will then be able to re-attach previously archived files by clicking the button and browsing to the folder containing the archive files to be reattached. You can multi-select files (using the Shift or Control keys).

Note: The following naming convention is used for the Archive files: `<Logger Name>_<Start Date>_<Start Time>_<End Date>_<End Time>` where the format for the Date is yyyymmdd and the format for the Time is hhmmss.
The re-attached archive files will be listed in the Attached Archive Files window. If you had selected **Generate Metadata for Archiving Files** in the System Settings, that metadata would appear in the window to the right.
4 Software Licensing

4.1 Software and Hardware Keys

MC Historian licensing is handled by a software key license registration system that does not require a hardware protection key. However, Mitsubishi Electric co. does offer an optional hardware key which you can purchase.

4.1.1 Software Licensing

The software key is a licensing key that resides on the hard drive of a computer. Each software key is used on a single, specific computer and is used only once. It is activated using a Site Key (license file) that is tied to the computer that is being licensed.

An activated license is required to use the software in full production mode. This license designates which products may be used, as well as the I/O point-count limit that controls the number of active data points (tags) that can be used by a system.

For important details about registering and activating software licenses for your MC Historian installations, refer to the MC Works64 .NET Licensing Readme.htm file, which is available on your MC Works64 installation DVD.

4.1.2 Hardware Key

The optional hardware key is a USB thumb drive (or flash drive) that you can move from system to system. MC Historian recognizes the hardware key on the system you have the key attached to. A hardware key is easier and is a more reliable way of moving a license from one machine to another than a software key.

Upon insertion of the USB key into an available USB port, the necessary drivers are automatically loaded.
A green status light will illuminate upon successful connection. Should the USB key be missing or unplugged during operation of MC Historian software, plug the USB key back in either within an hour of removal or upon system reboot; otherwise the hardware-based license will not be immediately recognized.

4.2 Licensing Utility

The Software Licensing Utility provides full authorization for use to any purchased MC Historian or MC Works64 product and its available options.

4.2.1 Running the Licensing Utility

To launch the License Utility from the Windows Start menu, select Programs > MELSOFT > MC Works64 > .NET Licensing > License Utility
4.2.2 License File

Once you have opened the Software Licensing Utility, you can browse for the Site Key (License File) itself. Either click on the **Browse...** button in the License File section of the window **OR** click on **File** in the top menu, then **Select License File...**

![Software License Activation for .NET](image)

This brings up the Windows Explorer so that you may browse for the License File itself. Once you have located the file, double-click it or click **Open** to proceed.
4.2.3 Activating the 30-day Trial/Emergency License

Within the Licensing Utility (Software License Activation for .NET) dialog box, you can click on the **Activate Trial/Emerg. License** box to initiate a 30-day trial/emergency license.

**Note:** This license can be activated only **once per machine**.

You will then see a warning about proceeding with activating the 30-day trial/emergency license. Click **Yes**, should you wish to proceed.
You will then see an additional warning confirming that you understand that enabling the trial license will invalidate any other software license that is currently active on the machine. Click **Yes** should you wish to proceed.

Once the 30-day trial/emergency license has been enabled, you will see the following messages:

The PC will then be authorized to run for a one-time only, 30-day backup period. The PC can be fully authorized at any time during or at the conclusion of this temporary backup period. Clicking **No** in the initial windows returns you to the Licensing Utility (Software License Activation for .NET) dialog box and preserves the existing license.
Note: Temporary backup license authorization is intended for urgent backup situations only. Clicking OK invalidates the existing license and activates a temporary backup authorization, permanently overwriting any existing license. Thus, please use caution when activating a temporary backup license authorization.

4.2.4 Killing a Software Key License

Killing a software key license deletes it and removes the current software license from the machine.

To Kill or Delete the Existing Software License:

1. Select **Kill Current License** within the Licensing Utility (Software License Activation for .NET) dialog box. Using this option, you can remove the current software license from the current machine.
A warning message appears on the screen as shown in the figure below.

![Warning](image)

**IMPORTANT**: If you kill your license, you need to get a new license from Mitsubishi Electric to restart your MC Historian product.

2. Click **Yes** to continue, or click **No** to exit. Clicking **Yes** displays one of the following warning messages.

If you are killing a trial or emergency license, once you click **Yes** you are done.

**Note**: A trial or emergency license cannot be credited back to the Web-based License Generator using the Kill Code.

If you are killing a permanent, registered license, after you click **Yes**, the following warning message appears. Notice that the message lists the old Site Key, and a Kill Code. It also lists a .TXT file that has been written to the PC's desktop; the file name begins with "KillCode". This file contains the old Site Key and Kill Code that are listed in the message.
3. Click Copy to copy the Kill Code to the Windows Clipboard so that you can paste it elsewhere, such as on the Mitsubishi Web Licensing Utility.

4. Look on the desktop for the KillCode*.TXT file. Keep this file, and copy it to a safe location! You will have to use the information it contains to confirm that you have killed your license (via the Mitsubishi Web Licensing Utility).

5. Proceed with the online steps described in 4.4.3.1 “Killing a License via the Mitsubishi Web Licensing Utility”

Note: If you uninstall the Software License Utility, the KillCode*.TXT file will be deleted. For this reason, make sure you copy the KillCode*.TXT file to a safe location or be sure to note or print its content before uninstalling the Software License Utility on the PC. [* = Site Key that was killed.]
4.3 License Viewer

When you purchase licenses, the licenses are measured in a point count that determines the number of OPC tags that you can use in your application. One point count is used for most MC Historian/ MC Works64 applications. There are two different modes for using tags in point counts:

- **On-demand mode.** A system for dynamically using licensed points, and then reusing the points as needed. The count at any instance includes only active points in use.

- **Configure mode.** A system in which all points are statically configured in a static central location, inside the Unified Data Manager. All configured points are counted against the point count.

The two mode types are not interchangeable and require you to buy a new license to upgrade your existing license status.

At any time, you can use the License Viewer to review the license status of products installed on that computer. You can access the License Viewer in either of the following ways:

- From the Windows desktop: click **Start > All Programs > MELSOFT > MC Works64 > .NET Licensing > MonitorWorX Viewer.**

- From the Workbench: from the Tools ribbon click the **Licensing** button. Or from the File menu, select **Tools**, and then **Licensing**. The License Viewer displays as shown below.
The tab that displays initially is the **Overview** tab, where you can see general information about the license for the server that the node points to. You can view license information for **MC Historian**, **MC Works64**, **AX Application**, **Data Connectors**, **BizViz products (under the AX tab)**, and **AlarmWorX Multimedia** product features by using the tabs for those products. To locate the nodes where individual product features are consuming the server's license counts, use the **Diagnostics** tab.
4.4 Web Licensing

You can use the Mitsubishi Electric Web Licensing Utility to generate a new license, kill a license and transfer a license. A new function to the Mitsubishi Electric Web Licensing Utility is to use it to upgrade your license.

Supported operating systems for using the Mitsubishi Electric Web Licensing Utility to upgrade your license include Windows 8 x64 (Pro or Enterprise Edition), Windows 7 x64 (Professional, Ultimate, or Enterprise Edition), Windows Server 2008 R2 x64, Windows Vista x64 SP2 (Business, Ultimate, or Enterprise Edition), Windows Server 2008 x64 or Windows Server 2003 x64. Using the utility will require Internet access and a Web browser (e.g. Internet Explorer 6.0 and up).

4.4.1 Acquiring a New Software License

Users of Mitsubishi Electric software can use the Mitsubishi Electric Web Licensing Utility to acquire a new software key license.

4.4.1.1 Issuing a New Software License

1. On the machine where you want the MC Historian license to reside, open the License Utility by going to Start -> Programs -> MELSOFT -> MC Work64 -> .NET Licensing -> License Utility. This should open the Software License Activation for .NET window.

2. You will see a dialog come up with a Site Code and “No Current Site Key” within the Site Key text box. Leave this window open.

4. The main page of the Web Licensing Utility will load. Click on the “Software” button to access the Software License Options.
5. You will be required to log in to access the Software License Options. Enter your email address and password and click on the “LOGIN” button. If you do not yet have an account, you can create one by clicking on the “Create New Account” link near the bottom of the page.

6. Once you have logged into the Web site, click on the “New License” link in the top navigation bar.

7. Enter your Product Registration Numbers and Customer Keys for the products to license, then click “Next”.

**Note:** Your Product Registration Number and Customer Key are usually inside the DVD package that Mitsubishi Electric co. sent to you.
8. In the next screen, you will be requested to identify the end user for whom the license is being issued. You can look up a list of users that have been previously entered by clicking on the “Existing End Users” link or can enter a new one by clicking on the “Create New” link.

9. Clicking the Existing End Users link will open a new window with a list of previously entered end users (either entered by you or tied to the product registration numbers entered in the previous screen). Select an end user from the list and click “Select” or double-click the selected end user. If you, yourself, are the end user and you are not listed in the grid, you can click on the “I am the End User” link to enter your data as the new end user. After identifying the end user, click on “Next”.
10. In the next screen, you will see a list of the products that are available for you to license. Check all the products that you would like to license. Copy the Site Code from the license utility of the destination machine and paste it into the Site Code box of the current Web page, then click on “Next”.

11. Review the license information before proceeding. Click on “Generate Key” to issue the new Site Key.
12. The next page will show you a summary of what will be your license, as well as your Site Code and License File.

13. Download the license file (*.glic) by clicking on the link. You will need this file to license the machine. **Note:** If you misplace the file after receiving it, you can use the View License link with your Product Registration Number to download it again.

14. In the Software License Activation Utility, click on the “Browse” button and look for the license file that you downloaded.

15. Once you have selected the file and the License File textbox shows the file path, click on the “Activate License” button.

16. You should then receive a popup message indicating the status of the license activation. You can click on “OK” to close the dialog.
17. The Software License Activation Utility should now show the current license information, similar to the following image.

![Software Licensing](image)

18. Notice that the Site Code may change, as expected, but the Site Key should be the same one you saw on the Web site.
4.4.2 Adding to an Existing Software License

2. Once you have logged into the Web site and accessed the Software License main page, click on the “Add to License” link in the top navigation bar.
3. Enter your Existing Site Key, Product Registration Numbers and Customer Keys, then click “Next”.

4. In the next screen, you will see a summary of the current license and a list of products that are available for you to add to the existing license. Check all the products that you would like to license. Copy the Site Code from the License Utility of the destination machine and paste it into the Site Code text box of the current Web page, then click “Next”.
5. Review the license information before proceeding. Select “Generate Key” as shown in the following image.

6. The next screen will display the new Site Key and the link to your license file. Follow steps 13 to 18 from 4.4.1.1 “Issuing a New Software License” to complete the licensing process.
4.4.3 Upgrading a Software License Key

There are four basic steps when it comes to upgrading a license via the Web Licensing Utility:

- Step 1: Kill the older version license and credit it on our Web site
- Step 2: Upgrade the license on our Web site
- Step 3: Uninstall the older version of software and install the newer version
- Step 4: License the newer version

The order in which you do Step 2 and Step 3 does not matter.

4.4.3.1 Killing a License via the Mitsubishi Electric Web Licensing Utility

See Section 4.2.4 “Killing a Software Key License” for the initial steps on how to kill a license within the Licensing Utility (Software License Activation for .NET) provided on the MC Works64 DVD. Be sure to take note of the Site Key and Kill Confirmation Code. This information is necessary to put the license back on the Mitsubishi Electric Web site.

Note: This information is also in the KillCode*.TXT file. [* = Site Key that was killed.]

Once you have the Kill Code, follow these additional steps:

1. Go to http://www.mcworkslicensing.com/

2. The main page of the Web Licensing Utility will load. Click on the “Software” button to access the Software License Options.
3. You will be required to log in to access the Software License Options. Enter your email address and password and click on the “LOGIN” button. If you do not yet have an account, you can create one by clicking on the “Create New Account” link near the bottom of the page.
4. Click on the “Kill License” link in the top navigation bar.

5. Copy the Site Key from the KillCode*.TXT file into the Site Key field on the Web page, then copy the Kill Confirmation Code into the Kill Code field on the Web page. Next, click on the “Remove Key” button on the Web page.

6. You will get a message confirming that the Site Key has been successfully deleted as shown in the image below. The products associated with the deleted Site Key will now be available to be re-licensed.
4.4.3.2 Upgrading the License on Mitsubishi’s Web Site

See Section 4.2.4 “Killing a Software Key License” for the initial steps on how to kill a license within the Licensing Utility (Software License Activation for .NET) provided on the MC Works64 DVD. Be sure to take note of the Site Key and Kill Confirmation Code. This information is necessary to put the license back on the Mitsubishi’s Web site.

Note: This information is also in the KillCode*.TXT file.
[* = Site Key that was killed.]

1. After you have copied your Site Key and Kill Confirmation Code in the previous step (either physically or electronically), you can now visit http://www.mcworkslicensing.com/
2. Click on the “Software” button to proceed. You will then be required to enter your email address and password for the site, as shown below. If you do not already have a login for this page, click on the “Create New Account” link near the bottom of the page.

3. Once you have logged in, click on the “Kill License” link in the top navigation bar.

4. Next, fill in your Site Key and Kill Code information that you copied while killing your previous license (see 4.2.4 “Killing a Software Key License”).

![Mitsubishi Web Licensing Utility](MitsubishiElectric.png)

**Kill License**

Please enter the Site Key to be credited and the associated Kill Confirmation Code.

Please enter Site Key and Kill Code exactly as shown in KILL.TXT file, including spaces.

- **Site Key**: [Redacted]
- **Kill Code**: [Redacted]

To remove a license for GENESIS32, do the following:

1. Click on Start, Programs, ICONICS Software License, and select License Utility.
2. Select the Kill License command from the Adobe menu.
3. Click on the Kill License option from the License Utility menu. The License Utility generates a dialog box containing your Site key and the associated Kill Code and stores this information to the KILL.TXT file in %SystemDrive%Program Files\ICONICS\License.
4. Enter your Site Key and Kill Code into the text boxes above; then click the Remove Key button.

To remove a license for GENESIS34, do the following:

1. Click on Start, Programs, ICONICS GENESIS34 License Utility.
2. Click the Kill License button on the main panel and click OK.
3. The License Utility opens a dialog box containing your Site Key and the associated Kill Code and stores this information to the KILL.34.TXT file on your current desktop.
4. Enter your Site Key and Kill Code into the text boxes above; then click the Remove Key button.
5. Once you kill the license on Mitsubishi’s Web site, you will receive an email containing the following information:
   - Site Key
   - Kill Code
   - Product for which you have killed the license

   The Web page itself should now look similar to the figure below.

   ![Kill License Page](image)

6. At this point, you have completed killing the license. Notice that in the final “Kill License” page, as shown above, it states that if the license is eligible, it can be upgraded to the latest version and it provides a link for availability.
4.4.3.3 Checking License Upgrade Availability

The easiest way to check if your license is available for an upgrade is by clicking the link on the page immediately after you kill the license. Clicking the link brings you to the Upgrade License page. You can also get to this page by clicking on the “Upgrade License” link in the tree control (third item).

Follow these steps to upgrade your license.

1. On the Upgrade License page, fill in your Product Registration Number and Customer Key. This is the same information you received in the Web page and in your email after you have killed the license on our Web site.
2. Click on “Next” when you have filled in the necessary information.
3. If the license is available for an upgrade, you will see the available license on the page.
4. Notice that the Product Description here shows a different product with an earlier version license (Version 8). Yours should reflect the license you have for your product. Check the available product that you would like to upgrade and click on “Next”.
5. The next page is a confirmation page. Check that the information shown is correct and click on the “Upgrade” button to proceed.
6. On the new page that loads next, you can see a list of upgraded products. Notice that the Product Description shows a license for a later version product (Version 9.2) instead of the earlier one (Version 8).

7. You should also receive an email with the license upgrade information.

4.4.4 Upgrading a Hardware Key License

Upgrading a hardware key license is similar to upgrading the software key license. You would follow the exact same procedure as upgrading a software license. In the case of a Hardware key License though, you will need the USB dongle in order to kill the license from it and put the new one onto the key.

4.4.5 Licensing the New Version

Now that you have upgraded the license, you can follow the regular procedure to license your machine with the new version. When it asks you for the Product Registration Number and the Customer Key, you can provide the same one. This information was sent to you in the last step of upgrading your license via email.
4.4.6 Software Key Replacement

Please fill in the online “Key Replacement Form” at "http://www.mcworkslicensing.com/" to start the replacement process of the original license if your license has been lost. Once your license has been recovered, follow the steps in the section titled, “4.4.1.1 Issuing a New Software License” to activate the new license.
4.5 Demo Mode

Without a valid license installed in your PC, it is still possible to use MC Historian/MC Works64 in Runtime mode. The software will check for a valid hardware or software license key on initialization. If none is found, MC Historian/MC Works64 runs in Demo Mode, which limits you to:

- Twelve hours of runtime
- Only 64 OPC tag connections (points) can be updated

Running MC Historian/MC Works64 longer than the 12-hour limit generates a message stating that the demo time has been exceeded. You must then exit MC Historian/MC Works64 and reboot the PC. On restarting MC Historian/MC Works64, you will get another 12-hour block of time in which to run. If there are more than 64 tags on a particular screen, gray keys (or whatever is configured as the Point Failure character) will appear in place of the actual I/O data.
5 Help and Technical Support

5.1 Online Help

MC Historian provides online help with descriptions and explanations of each application. Help is available from the Help menus and within most dialog boxes. You can access help from the following:

- Select Help Topics from the Help menu of the current application. This opens the help file for that application. To search for a topic in the help file, click the Find button and go through the Find Setup Wizard. Type or select the term you want to find, and then click on the topics.

- Click the Help button (or press the F1 key) in any dialog box to display context-sensitive help for that dialog box or application.

- Move the mouse pointer over an icon and pause for a moment to display pop-up ToolTips for quick help.

- Adobe® Acrobat® PDF files of all MC Historian documentation are included on the MC Historian product DVD in the Documentation section.
6 Notes

- Depending on the application settings, operation of the application may be unstable because the memory allocated by the operating system has been consumed up to the upper limit. Please configure the setting properly to prevent it.
## REVISIONS

*The manual number is given on the bottom left of the back cover.

<table>
<thead>
<tr>
<th>Print date</th>
<th>Manual number</th>
<th><em>Revision</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>October 2012</td>
<td>BCN(NA)-P5999-0011-A</td>
<td>First edition</td>
</tr>
<tr>
<td>March 2013</td>
<td>BCN(NA)-P5999-0011-B</td>
<td>Correction, Chapter 2</td>
</tr>
<tr>
<td>October 2013</td>
<td>BCN(NA)-P5999-0011-C</td>
<td>Correction, Section 2.1, Section 2.3, Section 3.14, Section 4.4</td>
</tr>
<tr>
<td>August 2014</td>
<td>BCN(NA)-P5999-0011-D</td>
<td>Addition, Chapter 6, Correction, Section 2.1, Section 4.4</td>
</tr>
<tr>
<td>April 2015</td>
<td>BCN(NA)-P5999-0011-E</td>
<td>Addition, Section 2.5, Section 2.7, Correction, Section 2.1, Section 3.9.3, Section 3.14, Section 4.2.4</td>
</tr>
<tr>
<td>May 2016</td>
<td>BCN(NA)-P5999-0011-F</td>
<td>Addition, Section 1.3, Correction, Section 1.1, Section 1.2, Section 2.1, Section 2.3, Section 2.6, Section 2.7, Section 2.8, Section 3.1, Section 3.2, Section 3.9.4, Section 3.10, Section 3.11, Section 4.2.1, Section 4.2.4, Section 4.3, Section 4.4.1.1, Section 4.4.3.1</td>
</tr>
<tr>
<td>May 2018</td>
<td>BCN(NA)-P5999-0011-G</td>
<td>Correction, Section 2.1</td>
</tr>
</tbody>
</table>

---

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2012 MITSUBISHI ELECTRIC CORPORATION
Intel and Pentium are either registered trademarks or trademarks of Intel Corporation in the United States and/or other countries.

Microsoft, SQL Server, Windows, Windows Server, and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

The company names, system names and product names mentioned in this manual are either registered trademarks or trademarks of their respective companies.

In some cases, trademark symbols such as “™” or “®” are not specified in this manual.
Specifications subject to change without notice.

When exported from Japan, this manual does not require application to the Ministry of Economy, Trade and Industry for service transaction permission.